5-Star Analysis Tutorial

This tutorial was originally created by Aaron Price for the Citizen Sky 2 workshop. It has since been
updated by Paul York to reflect changes to the VStar software since that time.

Looking at a Light Curve

What is a light curve? Light curves are a fundamental tool for variable star astronomy. They are
relatively simple and easy to grasp. They are simply a graph of brightness (Y-axis vs X-axis).
Brightness increases as you go up the graph and time advances as you move to the right.Here is a
light curve of epsilon Aurigae from a recent eclipse:
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This light curve shows that the star began at a brightness of magnitude 3 in 1982. Around mid-year
it began to rapidly dim until it reached a brightness of magnitude 3.8 at the end of the year. It
remained there until the beginning of 1984 when it began a slower climb back to normal
brightness. By the middle of 1984, it was almost back to normal brightness.
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Brightness (magnitude)

The above light curve was idealized, in that it was processed to include only the best observations
to make it clear. Now let’s look at a more complicated, real-world light curve. Here is a light curve
of the bright star Betelgeuse (aka Alpha Ori to astronomers) in the constellation Orion.

Light Curve for alf Ori
0.0
0.14 . .
0.2
0.3 e ecees e e .o . .
0.41 e o o * @ o0 wesse .o . e o o o
0.5 1 ce . -o.onu-u. . e e ee e o . e o e
. * o
0.6 1 wame o . * cmmencantces ® w o - e ce ® o0 o eweemes o
0.7 4 e oee o0 . ® oERS GEEBERCBEDEDES © . - o ® © 0 0 ©®@ CENEOUEE WS SO CEIRS S0
0.8 1 S ERENG ¢ B G0 SO WWANINEDE SHERE e o o moo e o conne .
05 evem e oo e e enacn et e st et e
1.0 1 . :--o.o SEMMeNese somn . Poel - * ®moeorw oom"o-u.u:uoﬁ. .
1.1 ™ cunems owssemmwess * ® . oo o ...o.on--.-..o.': .
1.2 1 ¢ cmmemmnwe o e ¢ @mme ®oees 0c o o o
1.34 o o * sewm oo
1.4 1 . - . . . -
1.51 . .
1.6 . .
2,454,300 2,454,400 2,454,500 2,454,600 2,454,700 2,454,800 2,454,900 2,455,00(
Time (JD)

Each dot in this light curve is a visual observation of the star submitted to the AAVSO International
Database (AID). The numbers on the X-axis are Julian Dates. That’s a standard format that
astronomers, especially variable star astronomers, use to record dates: roughly speaking, all dates
in the Julian Date system are expressed in terms of the number of days that have elapsed since
noon (GMT) on January 1, 4713 BCE. (For more information see http://en.wikipedia.org/wiki/
Julian_day). The light curve above covers observations made from around mid-2007 to mid-2009.

Notice that there are many observations made on the same dates. But sometimes they don’t

agree! That’s because we’re all human and so will make different estimates of a star’s brightness.
We chose this star as an example because it is very bright and very red. This makes it extra hard
for humans to make consistent observations. We call this variation in brightness estimates scatter.
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Mean Curves

Here is the same light curve, but with a mean curve drawn through it.

Light Curve for alf Ori
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® Visual -~ Means

The red line reflects the average observation made at that time. More precisely, we calculated an
average brightness of the star in 30-day increments then drew a line between the average points.
The vertical red bars you see along the line are error estimates. It’s a statistical value that provides
an idea of how much you can trust the red line. (There is a 95% chance that the real data value
falls on that vertical bar - a common benchmark that scientists use).

A good rule of thumb is to see whether you can draw a straight, horizontal line that intersects all
the error bars. If you cannot draw such a line, then you can be confident the variation is real. If you
can, it means there is no clear variation in the data. There may still be real variation, but you’ll
need more analysis to prove it. Notice that you cannot draw such a line through the first set of
data in the light curve above. However you can draw one through much of the data in the second
set. The second set is noisier (ie. it has more scatter) and we are less confident that it shows
variation.
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Make Your Own Light Curves - Web

There are two free variable star light curve generators you can use. One is on the AAVSO website
and the other is a downloadable Java application.

The online light curve generator is available by
clicking on the Data tab at the top of the
AAVSO home page, and then selecting Data
Access, followed by Light Curve Generator.

Data Getting Started

AAVSO International Database
(AID)

Portal for Researchers

Historic Light Curves

WebObs (Submit/Search Data)

Data Access »  Download Data in Ascii Form
Data Analysis » Light Curve Generator (LCG)

The AAVSO Photometric All- MyNewsFlash - Real-Time Data
Sky Survey (APASS) Delivery

AAVSOnet WebObs Search (Searches
AID)

The dialog box shown at the right hand side of
this page will appear. This may look
complicated but you can get started just by
filling out the first two or three boxes: To plot a
light curve, enter the abbreviated star name in
the first field (as shown at the right) and enter
the number of days or the date range you wish
to cover [The date range can be entered in
conventional format (as illustrated) or inJulian
Date format]. Then click Plot Data. It’s that
simple! The rest of the options are just that -
optional.

For instance, if you have submitted
observations of any of these stars to the
AAVSO, you can type in your observer code
here and your observations will be highlighted
on the plot, allowing you to compare your
observations with others.

Other options include the ability to select the
types of data you would like to have plotted,
whther you would like a mean curve to be
plotted, and various options for tailoring the
way the plot is presented.
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Light Curve Generator

WHAT IS THE NAME, DESIGNATION, OR AUID OF THE OBJECT?
| EPS AUR

DO YOU WANT TO LIMIT THE NUMBER OF DAYS PLOTTED?

200 Days

OR, DO YOU WANT TO PLOT A SPECIFIC DATE RANGE?

01/01/1982 START DATE
01/01/1985

END DATE (Click For Current Date)

PLOT DATA

WOULD YOU LIKE TO HIGHLIGHT A PARTICULAR OBSERVER?

!

WHAT TYPE OF MARK SHOULD BE USED FOR HIGHLIGHTING?
®) Crosshair Box

WHICH TYPES DATA WOULD YOU LIKE TO HAVE PLOTTED?

™ Visual R Differential and Step
U | Fainter than
B J Discrepant
CAY, H Unvalidated
Tri-R Tri-G Tri-B
Unknown Unfiltered w/V zero pt

Unfiltered w/R zero pt
WHAT DATE FORMAT WOULD YOU LIKE?

(» Calendar JD

SHOULD THE PLOT INCLUDE A LIST OF OBSERVERS?
© Yes No

SHOULD A BACKGROUND GRID BE DISPLAYED?

) Yes No

PLOT X-AXIS TICS

!

WHAT SHOULD THE SIZE OF THE PLOTTED POINTS BE?

I

WHAT SHOULD THE DIMENSIONS OF THE CHART BE?

800 WIDTH 450 HEIGHT

WOULD YOU LIKE TO ENFORCE A MAGNITUDE RANGE?

MINIMUM MAXIMUM

!
!

WOULD YOU LIKE ANY MEAN CURVES PLOTTED?

Days | VISUAL BAND

20 Days | V-BAND

PLOT DATA




Make Your Own Light Curves - Java

A more versatile and sophisticated software package called VStar, a visualisation and analysis
tool, is available from the AAVSO website at the following URL.:

http://www.aavso.org/vstar-overview

Simply click on the Download VStar Now button: Download VStar Now

The software requires Java and has been tested on Windows, OS X, Linux and other platforms.
The program should launch directly from your web browser. There is no need to formally install it.
The first time you run it, you will see something like this:

® O O VStar 2.16.0

= ol =~ L3 oy e

m Observations Means Model Residuals /}

\

Select a 'New Star' item from File menu \

\

® O O Select a Star

g | Click on this button to load data. You'll be prompted for the star name
: crznSiosEs_* | and a range of data you’d like to see, as shown in the dialog box on
ti',phaoﬁoms the left. VStar currently requires this date range to be in Julian Date
format, but a future version will accept standard calendar dates. Until

Other Star then, you can convert calendar dates to Julian Dates at this URL:
Minimum JD

2456072.50000 .

N http://www.aavso.org/jd-calculator

2456802.50000

| All Data?

| Cancel OK
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Make Your Own Mean Curves - Java
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‘alf Ori' loaded from database.

If this curve looks familiar, it is because it looks a lot like the one on page 1 of this tutorial.
Except that now we have some . Those are photometric observations
made by digital detectors instead of by the unaided human eye. You can add / remove this
and other series by clicking on View then Plot Control. Note that a “series” is just a name
for a collection of related data obtained over some time period.

800 VStar 2.16.0

ey sy Gl i st vae You can zoom in on a group of data just
R ovserons | e | o i | by drawing a box around it. You can

Light Curve for alf Ori

zoom out by left-clicking anywhere on the

graph.

You can plot a mean curve by selecting

Plot Control from the View menu and

then ticking the Means box under the

Analysis heading. Type in different values

| = e e in the Days per Mean Series Bin box to

b - e see how it affects the mean curve. This is
P a tricky part of analysis. How much can

S T e T T L you manipulate the parameters before
you are stretching your results?

ss (magnitude)

Brightne:

‘alf Ori' loaded from database.
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Phase Diagrams

When the same cycle repeats over and over as regularly as clockwork, we refer to this as periodic
behaviour. If a star (or any other phenomenon) is perfectly periodic, then its variation depends only
on where it is in its cycle, a quantity called the phase. For example, a 24-hour clock repeats the
same behaviour - with a period of one day. Each day the clock goes through one cycle, and each
cycle is just like every other cycle. If we want to know what the clock reads, we do not need to
know which day (cycle) it is, we just need to know the time of day (how far we are into the cycle).
For example, 2:15 am is 2 hours and 15 minutes into the cycle of the day.

A phase diagram will “fold” a light
curve on a certain period. This
allows us to see the shape of the
light curve as if all the data
occurred in the same cycle.

Consider the light curve of delta
Cephei to the right - it shows many
cycles so it’s difficult to see its
“real” shape.

To create a phase diagram,
choose Phase Plot from the
Analysis menu. For a first attempt,
just accept the default Period and
Epoch.

By using a phase diagram (right),
we put all of the data onto one
(fictional) cycle and can see the
shape of the light curve quite well.

In this example, we can see that
delta Cephei rises in magnitude
very quickly, but takes much
longer to drop in magnitude.

e 00 VStar 2.16.0
! e cie W A A S b A

Plot l Observations | Means = Model = Residuals |

Light Curve for del Cep

Brightness (magnitude)
.

‘del Cep' loaded from database.
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s el Rl AR S LA

Plot | Observations | Means = Model = Residuals

Phase Plot for del Cep

May 25, 2014 (database), period: 5.366266, epoch: 2436075.44500
.
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Brightness (magnitude)

Phase plot mode (del Cep)

Much more information on phase diagrams is available in Chapter 12 of the AAVSQO’s online
curriculum Varaiable StarAstronomy, available at the following URL:

http://www.aavso.org/education/vsa
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Period Analysis

One of the most important properties of a variable star is its period. Astronomers have lots of tools
at their disposal to look for periods in variable star data. One of the most basic tools is the
previously-mentioned phase diagram. A more advanced tool is Fourier Analysis*. VStar has
several Fourier analysis options under the Analysis menu. Choose DC DFT Standard Scan and on
the resultant graph, choose the Amplitude v Frequency tab. The graph below is the result of
running a period search on delta Cephei.

® O 6 Period Analysis (DC DFT) for del cep

EARNECE T4 Amplitude vs Frequenc Data = Top Hits

Period Analysis (DC DFT) for del cep

(series: Visual)

0.2
0.225
0.2
0.175
Jo1
2
S 0.125
E
< 0.100 ‘
0.07 ‘ |
n | o 1 : | ,’
0.025 | H ' M | ' ‘lll s ;; !
0,000 e Vsl M»’ VT NMWVHmmn\.‘f'J“ﬂ,'n'hlﬂ'wmwM‘v"kﬂl\‘MWI".*,Mw'rn*.-'m“d‘"l")"*-,‘\,'Hbq'."WM"J,M‘.\‘h‘\,mr,q‘.'*‘ b b
0.00 0.05 0.0 015 020 025 030 035 0.40 0.45 050 055 0.60 0.65 070 075 0.80 0.85 090 095 1.00 1.05 1.10
Frequency

I Amplitude vs Frequency Amplitude vs Frec_snwl

(¥ Show top hits?

New Phase Plot Find Harmonics Dismiss

Amplitude is a measure of the change in brightness detected. The Frequency is the period in
cycles per day. The pronounced peak around 0.2 means that delta Cephei completes a cycle every
five days or so (1 divided by 0.2 = 5). In general, you should look for peaks that stand out above all

their neighbours, as this one does.

* A full discussion of Fourier Analysis is beyond the scope of this tutorial. But a good start is an
online time series tutorial written by Dr Matthew Templeton. It is available at this URL:

http://www.aavso.org/time-series-tutorial
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